
SANDIA REPORT

SAND99-8202
Unlimited Release

. Printed November 1998

Diffuse II - A Hydrogen Isotope Diffusion
and Trapping Simulation Program Upgrade

M. F. Hardwick, S. I_. Robinson

!%epared by

SSnd!a NaWxa! La:nr+mies
i+khq~erqw, hew KWICO 8?125 and Live:more, California 94550

.%nr!z k a ,,wl:yxcgsm !aborarory otierated by Sandia Corporation,

: L2c~.h=ed Mew-t C.crnpar.:, fc, the United States Department cf

Energy under Contract CE-AC04-94AL85000.

.,.

. .

,.
,,

SF2900Q(8-31 )



Issued by Sandia National Laboratories, operated for the United States Depart-
ment of Energy by Sandia Corporation.

NOTICE: This report was prepared as an account of work sponsored by an
agency of the United States Government. Neither the United States Gover-
nment, nor any agency thereof, nor any of their employees, nor any of their
contractors, subcontractors, or their employees, make any warranty, express or
implied, or assume any legal liability or responsibility for the acmracy,
completeness, or usefulness of any information, apparatus, product, or process
disclosed, or represent that its use would not infringe privately owned rights.
Reference herein to any specific commercial product, process, or service by
trade name, trademark, manufacturer, or otherwise, does not necessarily
constitute or imply its endorsement, recommendation, or favoring by the
United States Government, any agency thereof, or any of their contractors or
subcontractors. The views and opinions expressed herein do not necessarily
stite or retlect those of the United States Government, any agency thereof, or
any of their contractors.

Printed in the United States of America. Tnis report has been reproduced
directly from the best available copy.

Available to DOE and DOE contractors from
Office of Scientific and Technical Information
P.O. BOX 62
Oak Ridge, TN 37831

Prices available from (615) 576-8401, FTS 626-8401

Available to the public from
National Technical Information Service
U.S. Department of Commerce
5285 Port Royal Rd
Springfield, VA 22161

NTIS price codes
Printed copy: A03
Microfiche copy AO1



SAND 99-8202
Unlimited Release

Printed November 1998

Diffuse II -A Hydrogen Isotope Diffusion and Trapping
Simulation Program Upgrade

Michael F. Hardwick
Steven L. Robinson

GTS Engineering Department
Sandia National Laboratories

Livermore, CA 94551

Abstract

Diffuse is a finite difference computer program which maybe used to calculate the one-dimensional diffu-

sion and trapping of atoms in a host material under general initial, source, and boundary conditions,

Diffuse was originally written in Fortran prior to 1980, and rewritten in 1983 in order to run on the Sandia

Cray computers in use through the early 1990’s. When the mainframe computers were retired, the Gas

Transfer System (GTS) Development Department ported the code to the PC platform, where it ran as a sim-

ple console application. All graphical output was lost during this port. GTS code developers have completed

an upgrade that provides a Windows 95/NT Diffuse application and restores all of the original graphical out-

put. This upgrade is called Diffuse II version 1.0. This report serves both as a users manual for Diffuse II v

1.0 and as a general software development reference.
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Executive Summary 

Diffuse is a finite difference computer program which may be used to calculate the one-dimensional diffu- 
sion and trapping of atoms in a host material under general initial, source, and boundary conditions. 

Diffuse was originally written in Foman prior to 198d and rewrittsn in 1983 in order to run on the Saadii 
Cray computers in use through the early 1990's. When the mainframe computers were retired, the Gas 
Transfer System (GTS) Development Department ported the wde to the PC platform, where it ran as a sim- 
ple console application. All graphical output was lost during this port. GTS code developers have completed 
an upgrade that provides a Windows 95m Diffuse application and restores all of the original graphical out. 
put. This upgrade is called Diffuse I[ version 1 .O. 

This report serves both as a user's manual for Diffuse II v 1.0 and as a general software development refer- 
ence. The intent of the software description is to help other developers understand the development philoso- 
phy and software structure so that bugs may be more easily eliminated and kture upgrades may be 
simplified. 

i- T U  mam 
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User’s Manual

Scope

This user’s manual is not intended as a comprehensive guide to the physical models implemented in the Dif-

fuse code. Model specific information can be found in the original DIFFUSE user’s manual 1. This manual

serves only to describe how to use the Windows 95/NT Diffuse II upgrade.

Overview

Diffuse is a finite difference computer program which calculates the one-dimensional diffusion and trapping

of atoms in different materials under general initial, source, and boundary conditions. Diffuse enables the

user to compute, singly or in combination:

1) bulk diffusion of one or two species in a multi-layer medium, including a temperature gradient, and

2) tritium decay resulting in trapped helium upon decay (i.e. no migration).

While the computational code supports trapping and detrapping, this version of the user interface, written

specifically for gas transfer applications, does not support the introduction of trap distributions. The inclu-

sion of trapping support would allow the code to be more broadly applicable and should be considered an

important upgrade for the next release.

The diffusing species may arise from:

1) implantation

2) diatomic gas phase entry at surfaces, or

3) initial surface concentrations.

Simple geometries for which results may be computed are:

1) a semi-infinite slab,

2) an infinitely long solid or hollow cylinder, or

3) a solid or hollow sphere.

Code History

Diffuse was originally written in Fortran prior to 1980, and modified by M. Baskes in 1983 enabling it to

run on the Sandia Cray computers in use then and through the early 1990s. The partial differential equations

of Fickian diffusion were solved using a Sandia-written numerical solver. Diffuse ran initially on CDC com-

puters, using cardfile inputs. Later, it ran on the Cray computers first under COS and then CTSS. The final

configuration used the VAX computers for inputioutput to the Cray computers. In this configuration, termi-

nal operation was available.

1.Baskes, M. I., DIFFUSE, Sandia National Laboratories, SAND83-8231, June 1983
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In the mid- 1990’s the Cray computers on which the code ran were relocated to Sandia/NM and over the next

few years became less and less accessible. Several responses were developed. Initially, Diffuse was incorpo-

rated into an integrated design-tool environment using a CORBA (Common Object Request Broker Archi-

tecture) wrapper. This activity was funded as a HS pilot under the Product Realization program, but ended

with no plans or funding to maintain the design tool environment. When the mainframe computers were

finally retired, Gl% Development Department ported the code to the PC platform, where it ran as a console

application. Unfortunately, because the Diffuse plotting routines required a graphics library that was not

available for the PC platform, all graphical output was lost. During this upgrade, the console application was

converted to a Windows 95/NT application with a modern user-interface and all graphical output was

restored.



Installation

Although Diffuse is intended to be installed on only a limited number of machines, an automated installation

program was developed to automate installation onto a Whdows 95/NT computer. The installation program,

Di@seSetup.exe, was created with InstallShield Express 2. The program copies the required files to the

appropriate directories on the selected hard drive, makes required registry updates, and creates program

groups and menu items.

Run Diffuse II by double-clicking the Difiin.exe icon or an appropriate shortcut or by selecting the Diffwin

menu item from the Start menu.
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Diifuse Display 

l%e Diffuse II display is shown in Figure 1. The Dfhrse II main h e ,  which also displays the name ofthe 
currently selected document in its title bar, houses the system menu, toolbar, and main output window. The 
main 0uQm window contains a single srapb that digplays calculation results in plot form. The D m e  Input 
tabbed dialog, also called a pnopeny sheet, provides the user with the means to e n m  the problem definition. 
Unlike the main output window, the tabbed dialog is not conseaiaed to remain within the main fnum bound- 
aries. It can be moved to any d e s i  location on the -. 

D i e  II allows the user to manipulate multiple seasioas (documents) at the same time, a capabiity that is 
useful wben comparing several different problems. Selecting Nnv from the File menu star& an add i t id  
session and presents an additional main output window and its contained graph. The number of concurrent 
sessions is limited only by the amount of available memay and the user’s ability to maintain an understand- 
ing of the multiple windows. Although multiple main output windows may be displayed, only a single input 
tabbed dialog window is shown, The values in the tabbed dialog always mrnspond to the currently selected 
main output window. 

Data from a Diffuse II swpion may be stored by selectingsavC aSm As from the File menu. Ifthe data 
has not yet been saved or if Save As is selected, the system presents the Savcle dialog that allows the usrr to 
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select a file name and location for storage. Selecting Open from the File menu restores saved data. In this

case the system presents the Open dialog that allows the user to browse for the desired fiIe. Plot data in the

main output window may be previewed or printed by selecting Print Preview or Print from the File menu.

Only the problem definition data (i.e., the data contained in the three pages of the input tabbed dialog -- see

“Input Tabbed Dialog” on page 12) is saved. When reading data from an existing file, the user must click the

Calculate button to recreate the problem solution data.

The next two manual sections describe the input tabbed dialog and the main output window in more detail.
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Input T M  Dial- 

Tbe iabbed d i o g  is used to enter information that defines the probiem to be enalyzed and is initialized with 
default psrmwfm appropriate ' f a  a single layer of stainless steel subjected to a tritium gas pressun on one 
aide while the other is held at zero coocentration. The input tabM dialog contains three pages, each 
M by clicking the M a t e  tab. The first page defines the material sample, the second page defiaen 
pm%ram contml parametsrs, and the thkd page &fines the envimnmm and boundary conditions. 

The SMIplC page, shown in Elgure 2, allows the user define the material sample to be evaluated. In gsaaal. 
the sample is a composite of a maximum of five individual layers of diffewat matuials. The number of lay- 
em in the sample of interest is selected in the No. ofSmples list box. General geomeuic data is e n d  in 
the eecond scnion of general sample dsta. A planar, cylindrical. or spherical sampk Beomary may be 
selected from the Shape list box. The value entered in thc Imide Radius edit box applii of come, only to 
cyliadrical and spherical geomehies. Tbe individual layer thickness is enterndinthe 'l%&w.wdtbox 
while the distance of interest into the overall composite sample is eMered into the Pmfilc edit box. Tbe po- 
file distance value determines the distance scale for plotting and allows the wer to focus the concentration 
plot results on the near surface area of interest. For wnveniencz!, the +le value may be quicUy set to the 
composite tbiclmess by clicking the max button. 

. 
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The identity of the gas(es) to which the composite sample is subjected is defined in the Di@sing Species

data section. The number of species, which is limited to a maximum of two, is selected in the No. Species list

box while the individual gases are identified by the selections in the Species 1 and Species 2 list boxes.

The material properties and boundary conditions for the individual layers are

defined in the right side of the Sample Page. The layer for which properties are

to be defined is selected in the Sample Number list box, the upper limit of which

is determined by the No. of Samples value. For convenience, entire data sets for

the common materials shown in Table 1, may be entered by selecting the

desired material in the A4at’1Name list box. Individual property values,

described in Table 2. maybe overridden by simply entering the desired value in

the appropriate box. Because this version of Diffuse II does retrieve material

information from a database, the new data set cannot be stored under the same

or different material name. However, saving the problem data file, as later

described, does save all user entered data.

The interface boundary conditions for each layer are defined in the Boundary

Conditions section of the Sample Page. The available interface options are

shown in Table 3. Note that all interior interfaces should use the lnte#ace

boundary condition

Clicking the Calculate button initiates a Diffuse II calculation and, if success-

ful, updates the output in the main window.

Table 2: Materiaf Properties

Table 1: Available
Materials

Aluminum

Beryllium

Carbon

Copper

Inconel

Iron

Molybdenum

Nickel

Stainless Steel

Titanium

Tungsten

Vanadium

Zirconium

Ed eV Activation enthalpy for dtiusion

DO cm2 amu~ / sec Pre-exponential constant for diffusion

Es eV Activation energy for volubility

so afrac / atm’h Pre-exponential constant for volubility

Density atoms / cm3 Atomic packing density for the host matrix

Q-star eV Heat of transport for the diffusing species

Stick Sticking coefficient for adsorption from gas (Oto 1)

Table 3: Boundary Conditions

Reflection The boundary reflects all diffusing species

Zero Cone. Diffusing species concentration is zero at the boundary

Seivert’s Law Concentration is proportional to the square root of pressure

Recombination Diffusing species must recombine at the boundary according to a rate equation

with a rate constant determined by other the other user-defined parameters

interface Specifies an internal layer interface
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Control Page 

The Conrmf page is shown in Figure 3. Here the user enters information that controls execution of the com- 
putational pert of Diffuse II. During the computation, the composite sample is divided into a one-dimen- 
sional mesh with a number of nodes equal to the value entered in the Number ofmesh nodes edit box. 

Although this version of Diffuse II does not use the Number ofcycle repertrs value, the edit box is included 
to simplify its inclusion into the next releaseme Number ofcycfe repeats defines the number of times that 
the sequence of steps defined in the Data page is re+. 

The remaining control parameters allow the user to dctcrmine the relative distribution of mesh points 
throughout the material layers so that large concentration gradients may be appropriately represented. The 
values in these edit boxes are evaluated in a relative, not absolute, manner. A layer with a larger value 
receives a propottionally greater number of mesh nodes. If all values are equal, the mesh nodes are uni- 
formly distributed. 

l A  



The Data page. shown in Figun 4. allows the user tn enter infamation describing a series of pressure and 
temperature boundary conditions tn which the composite sample is subjected. The value in the Number of 
DATA c a d  list box determines the number of step in the boundary condition sequence and is limited to a 
maximum of five. The individual step may be selected for data entry or review by selecting the appropriate 
card number from the Cani Number list box. The Time interval edit box contains the time step for the 
selected card. The Number ofprint edits list box is not u d  by this version of Diffuse II. 

The pressure boundary conditions for each of the gas species identified in the Sample page are defined in the 
Pnssarns section of the page. Here, v a l w  are entered for each species and for the front and back sides of 
the composite sample. Note that if only one speciea is selected in the sample page, the species 2 edit boxes 
are grayed and cannot be accessed. Each p s u r e  boundary condition is specifkd by two values, an initial 
value and a ramp (Ap/time). By entering appropriate values in these edit boxes for each data card. the user 
may specify a piecewise Linear approximation tn a continuous time-varying pressure condition. Note that 
Diffuse II does not calculate the pressure increme due to tritium decay in a closed volume. To model such a 
cast. the user must calculate the tritium partial prcssure time history, dewmpose it to a piecewise linear 
approximation. and enter the appropriate initial and ramp values for each data card. 

Tempemires may be specified for each side of the individual material layers that Comprise the composite 
sample. Similar to the case with the pmsure boundary conditions. only those edit boxes associated with 
deked material layers from the Sample page are enabled for user input. Also similar is the fact that each 
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temperature is defined by two value& an initial value (K) and a ramp (Wsec). By entering appropriate values 
in these edit boxes for each data card, the user may specify a piecewise linear approximation to a continuous 
time-varying temperature condition. Note that Diffuse II interprets tempesaturc values of zero as k ing  equal 
to the value. from the previous layer. Themfore. to enter a uniform time-invariant mnperamt condition, the 
user need only enter the desired temperature in the upper left edit box while ensuring that dl other values are 

zero. Dith.iw II does not calculate t e m p e m  increases due to tritium self-heating. 

Main Output Window 

The main output window, as shown in Figure 5, contains a graph window for each 
open document The graph window provides acceas to plots that display species 
concentration profiles, species release rates, or species release integrals. In addi- 
tion, each plot contains an individual curve for each data card that is defined. The 
curves are identified by the legend above the graph. When the user clicks any- 
where in a graph pane it becomes active and therefore the target of all plot related 
toolbar and menu commands. The flew menu, shom in Figure 6. allows the user 
to select the plot type f a  display. The available plots types are descrikd in W e  6: 
4. Each plot type holds severd different plots; the exact number is dependent 
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Table 4: Available Plot Qpea 

* -  - .  # .  * . 
Concentration Diffuvng spwes 1 (DS1) 

Sum (DS1+ DP1) 
Dmusirg specier 2 (W) 
Decay product 2 ( D e )  
Sum (DS2 + DP2) 
Sum (DS1+ DS2) 

Release Rate Diffusingspedes 1 (hont) 
D - g - l W )  
Drnsing spedes2 (front) 
Diffusing specieg 2 (back) 
Dmusii s p o k  1 (front) 
Dlffusbspecieol W) 
Diffusingspedesz(frwd) 
DyfudngsPedee2w) 

Species (or sum) concentration as a funchon of 
profile Oeoay produd 1 (DPlf distanceintothemmpasitesample 

Rate of relaase of species from dtherthefrmt 
or back surface of the composite sample. Neg- 
ative value is into the materisl. 

Rate of release of speciesfrom either the front 
or back surface of the mmposae sample. Neg- 
a h  value is into the material. 

Relsaae lnte 
g d  

Plot type buttons 

prsure 7: Toolbv 

Plot mil buttons 

upon the number of species defined. As an alternative to using the View menu for selecting plot type. the 
user may click one of the three plot type buttons on the toolbar, as shown in Figute 7. The plot scroll buttons 
allow the user to scroll forwards or backwards thmugh the list of available plots. An additional toolbar but- 
ton. the Tabbed Dialog Viibility button, allows the user to alternately show and hide the tabbed dialog. 

Right-clicking on the graph reveals the Graph Contml property pages, as shown in Figure 8, and allows the 

user to interactively change the graph’s appearance. The @e number of available pages provides access to 
almost all graph characteristics. Note, however, that changes made to one graph a&ct all others. 



r 
~~~~ 

The Option menu, shown in Figure 9, allows the user to select numerical units for e n t e d  and displayed 
time and pressun quantities. This option pe,rmits the enny of undustandabk numerical v a l w  forthe p b  
lem of interesr Available time units include seconds, days, months. and years while available pnssure units 
include atmospheres and pound per square inch (psi). 

. 
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Hewing the Input and Output Files 

The tiles input to and written by the Diffuse II computational program can be viewed by selecting the 
desired item from the frnal two presented in the Kew menu. The user may select either the last generated 
(current) input file or currently selected plot data file. Because each calculation overwrites the files genec- 
ated during the previous calculation, only the most recent file sets are available. This version of Diffuse II 
includes an integral file viewer that is aware of data changes made by the user. Once a calculation is per- 
formed, the new data is automatically displayed in the open viewer. 

Jnpnt File 

The input file, indfdut. is a Fortran  mel list for- 
matted text file read by the Diffuse D: computa- 
tional program. It may be viewed by selecting Lasf 
Input File from the V i  menu. CIiuse II then 
srar$ the data viewer and loads the last input fde 
generat&. This simple viewer only allows the dis- 
played contents to be written to a file OI copied intn 
a buffer for later pasting into mother appkation. 
A sample display is shown in Figure 10. Reference 
1 provides a detailed description of each of the 
narnelist variables. 

1 plot Data File 

The plot data tiles are formatted text Nes mat con. 
tain the numerical data used to generate the plots in 
the graph display. The data used to gemate the 
currently selected plot may be displayed by select- 
ing Last Plot Data fmm the Wew menu. D i s e  II 
then starts the data viewer and loads the last plot 
file generated for the selected plot type. A sample 
display is shown in Figure 11. When more than one 
data card bss been mated during problem defini- 
tion, selecting this menu option displays the data 
card selection dialog shown in Figure 12. Here the 
user selects the desired data card n u m h  from the 
list box. Clicking the OK button the displays the 
requested data 

--.r.. 
t i ~ 3 . 1 5 m ~ i . 0 ~ 7 .  
t d - 3 1 3 ,  0.  
rw.0 .  0, 
p0-310.229, 340.229. 340.229. 
WJlW-0. 0. 0.  0. 

Figurr 10: Sample input 6k 
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The plot data tile concentration, release rate, and release integral columns are labeled with a subscripted 
Slphabetic code, where c =concentration, yr  = release rate, and yi = release integral. The first subsc@ 
=fer8 to the species number while the second refers to the &@using species itself (I), its decay product (2). 
or the sumof the two (3). 

20 



Miscellaneous

Code Limitations

Diffuse II currently performs only minimal input value checks. As a result, if the user errs when entering

values, the Diffuse computational routines may receive data that is not completely appropriate. Depending

upon the nature of the error, the computation may complete and provide erroneous output data that can gen-

erally be identified in the output plots. On the other hand, certain input errors may result in more dramatic

responses. If the calculation does not complete in a short amount of time, the user can open the computa-

tional message output window by clicking on the DiffuseSG2 button on the taskbar. If the calculation is

experiencing dit%culty, a message maybe displayed in this window. Note that the taskbar button is available

only while the computational routines are executing. Wile future versions of Diffuse II may implement a

more complete input-checking algorithm, the current version places the responsibility for ensuring consis-

tent input primarily upon the user.
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Software Description

This section briefly describes the Diffuse II software development philosophy and structure. The intent of

recording this information is to provide future developers with the basis needed for code debugging or

upgrading.

Development Environment

The Diffuse H upgrade was developed on a Windows NT PC using the Microsoft Vkual Studio integrated

development environment (IDE)l. Visual Studio provides an environment that enables a developer to effi-

ciently write, test, and debug code. All C and C++ code was compiled with Microsoft’s Visual C++ 6.0 com-

piler while the Fortran was compiled with Digital Vkual Fortran 5.0 compile#.

Code Structure

Diffuse II contains three executable files, Di&Vin.exe, Diffsub2SGexe, and Sgw32.exe. DiffWin.exe is the

executable image created by compiling and linking the C++ user interface code while Diffsub2SGexe is the

image created by compiling and linking the Fortran computational code. Sge32.exe is a local automation

server that produces the plots in the graph pane of the main output window. The user runs Diffuse II by exe-

cuting the interface image. When the Calculate button is clicked, the user interface runs the computational

code by spawning a new synchronous process. Once the computational code terminates, the system destroys

that process and returns control to the interface code. With this structure, the interface and computational

codes run in separate process spaces and do not share memory.

The described structure was selected for one primary reason. The original Fortran Diffuse console applica-

tion, from which the computational code was derived, used very little interactive user input. Rather, all

important inputs were provided in a namelist formatted text file. Additionally, the code wrote all important

output data to similar text files. This file I/O configuration of the original Diffuse provided a simple means

of file-based communication between the interface and computational codes and required a minimum of

Fortran source modification. indifdat istheinput file written by the interface while difi.txt and di$kg* (* = 1

to 15) are the summary report and plot data files written by the computational routines.

Computational Code

As previously mentioned, the finished computational code is a minimal modification of the original Fortran

1. Microsoft Corporation, One Microsoft Way, Redmond, Washington 98052-6399, w

www. microsoft.com

2. Digital Equipment Corporation, Maynard, Massachusetts, httn://www.dec.com
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Diffuse application and is itself an executable application. The modifications, which are documented in the

source code, include minor syntactic changes to access the Vkual Fortran QuickWin run-time library, which

adds some windowing capabilities to the application. These statements prevent the application from display-

ing a window when it executes. Rather, the application window is minimized and is visible only as a taskbar

button. While it is active, however, the user may click the button to expand the window. The computational

segment was built as a Standard Graphics application using the Visual Studio 97 AppWizard. A Standard

Graphics configuration was chosen because it supports the QuickWh library routines and allows the win-

dow to be minimized at execution.

When it executes, the code expects to find a namelist formatted text file called indtfdat in the same directory

defined by the DIFFDIR registry variable. If the file is not present, the code will not execute successfully.

During execution, the code writes several files: di~txt, which contains text-based summary report, dijlplt,

the summary plot file, and the individual plot files. The number of individual plot files is determined by the

number of data cards identified in the problem definition. The generic individual plot file name is difkg*,

where * is an integer between 1 and 15. The file number is given by:

filenumber = 3(cardnumber - 1)+ graph number+ 1

where card number = the data card number selected by the user (1 through 5) and graph number= O for con-

centration plots, 1 for release rate plots, and 2 for release integral plots.

User Interface Code

The user interface code, written in C++, was built using Visual Studio’s MFC (Microsoft Foundation Class)

AppWlzard as a MDI (multiple document interface) application. The Microsoft Foundation Classes provide

object-oriented wrappers around most of the Windows 95/NT API (application programming interface) rou-

tines while the MDI architecture allows a user to concurrently work on several Diffuse II documents. The

finished interface code comprises many classes, some of which were generated by the AppWlzard, most of

which were developer-generated, and some of which were generated by the inclusion of software compo-

nents. The classes are summarized in Table 5. Some of the more interesting classes are described in more

detail below.

Property Sheet and Page Classes

The property sheet is the tabbed dialog that contains each of the three property pages. Although the user

enters data in these pages, it is stored communally in the document object. The MFC UpdataData( ) state-

ment transfers data to and from the property page edit and list boxes and the dialog class member variables.

Two dialog class member functions, SetA4emberData( ) and SetDocumentData( ), transfer data between the

corresponding dialog and document member variables.

Each page is responsible for maintaining its own display. Display maintenance includes routine tasks such as
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Table 5: Important Classes

CAboutDialog

CChildFrame

CControlDlg

CDataDlg

CDiffMsgDlg

CDiffWinApp

CDiffWinDoc

CDiftWinView

CGetDCDlg

CGraph

ClnputPropSheet

CMainFrame

CSampleDlg

CSplashDlg

CSplashThread

The About Diffuse dialog class. This dialog is displayed from the Help
menu.

The child frame window class.

The Control dialog (property page) class

The Data dialog (property page) class

The calculation animation dialog class

The application class

The document class

The view class

A dialog class that allows the user to select a data card number when view-
ing plot data

The graph class

The input tabbed dialog (property sheet) class

The applications main output frame window class.

The Sample dialog (property page) class

The splash screen dialog class

A thread class used for the splash screen display

filling the edit boxes with appropriate values, enabling and disabling various controls, and storing edit box

data to the member variables.

.

Document Class

The document object, represented by the CDif/WinDoc class, stores all of the data required for creating the

computational routine input file, indifdat. It writes this file once it is instructed to initiate a calculation. It

then spawns the computational process, reads the resulting data from the appropriate disk files, and updates

the graph. The document is also responsible for serializing all of its data and therefore implements all file

input and output. A simple schema number written to the data file provides version control for future back-

ward compatibility.

View Ciass

The view class, CDi~inView, contains a single CGraph (provided by a purchased software component

called Graph Control. 1, object that fills its client window. This graph is loaded with data and redrawn in

response to user requests via the menu or toolbar items or in response to an updated calculation.

1. Graph Control, Pinnacle Publishing, Inc. PO Box 888, Kent, WA 98035-0888, (425)251-1900, Fax (425)

252-5057, httn:llwww.ninrmh. corn
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Data Viewer Class

As previously mentioned, this version of Diff use II uses an integral data viewer to display the contents of the

input and output files. This functionality is implemented in the CDataWewerDlg class and is currently lim-

ited to data display, serialization to a file, and data copy to a buffer. Although no viewer printing support is

yet provided, the copy ability allows the user to trm’sfer the data to another application, such as NotePad,

and then print. The viewer is able to receive an Updateln~o( ) command, generally sent by the document

after it has completed a calculation, and fill the viewer with the latest data. Adding direct print capability to

the CDataEewerDlg class is a desireable upgrade.
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